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The following lesson has been adapted from the Library Carpentry’s Tidy Data 
lesson. These materials are free to share and adapt as needed. 

https://librarycarpentry.github.io/lc-spreadsheets/
https://librarycarpentry.github.io/lc-spreadsheets/
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Lesson objectives 

What we will cover today: 
 
● Good data entry & organization 

practices, such as formatting data 
tables in spreadsheets 

● How to avoid common formatting 
mistakes 

● Dates as data (beware!) 
● Basic quality control and data 

manipulation in spreadsheets 
● Exporting data from spreadsheets 

What we will not cover today: 
 
● How to do statistics in a 

spreadsheet 
● How to do plotting in a 

spreadsheet 
● How to write code in spreadsheet 

programs 
● Data analysis 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Using spreadsheets 
programs for data 
organization 

 
What we usually use spreadsheets 
for:  
● Data entry 
● Organizing data 
● Subsetting and sorting data 
● Statistics 
● Plotting, and more 

 
Much of your time when you’re 
producing a report will be spent in 
this ‘data wrangling’ stage. It’s not 
the most fun, but it’s necessary.  

Good data organization is the 
foundation of much of our 
day-to-day work as academics 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A quick note about spreadsheet programs 

There are a number of programs to 
use on a desktop or web browser: 
 
● LibreOffice Calc (free) 
● Microsoft Excel 
● Apple Numbers 
● Google Sheets 
● Gnumeric 
● Apache OpenOffice Calc 

Things to keep in mind: 
 
● Commands may differ between 

programs, between operating 
systems (i.e. Excel looks 
different on Mac vs. Windows), 
and between versions 

● My interface may look different 
than yours and that’s okay! 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Problems with spreadsheets 

● Spreadsheets are good for data entry, but the reality is that we use it 
for much more than that: creating data tables, generating summary 
statistics, and making figures 

● Spreadsheet programs are not suitable for many tasks and jobs, 
and we need to consider when to use other programs for our specific 
tasks or goals 

● Spreadsheet programs can sometimes be suitable for data cleaning, 
prior to importing data into a statistical analysis program. 
○ We will discuss data cleaning software, such as OpenRefine, at 

the end of the presentation 
 

https://openrefine.org/
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Questions to ask yourself about your data or project 
When to use Excel? When you: 
 

● Want a flat or non relational view of 
your data  

● When your data is mostly numeric 
● Frequently run calculations & 

statistical comparisons on your data 
● Want to perform sophisticated what-if 

analysis operations on your data 
● Want to keep track of items in a simple 

list, either for personal use or for 
limited collaboration purposes 

When to use a database (Access, SQL)? 
When you: 
 

● Anticipate many people working in 
the database 

● Anticipate the need to add more 
tables to a dataset that originated as 
flat table 

● Want to run complex queries 
● Want to produce a variety of reports 

Adapted from “Using Access or Excel to manage your data” 

https://support.microsoft.com/en-us/office/using-access-or-excel-to-manage-your-data-09576147-47d1-4c6f-9312-e825227fcaea
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Formatting data 
tables in 
spreadsheets 

● The most common mistake we 
make is treating a spreadsheet 
like it is a notebook by relying 
on: 
○ Context 
○ Notes in the margin 
○ Spatial or visual layout of 

data & fields to convey 
information 

○ And making it look ‘pretty’ 

Well-formatted tables and data 
organization is the key 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Keeping track of your analyses 

1. Create a new file or tab with your cleaned or analyzed data. Do not modify 
that original dataset, or you will never know where you started! 
 

2. Keep track of the steps you took in your clean up or analysis. You can do 
this by: 
a. Creating a new text file 
b. Create a new tab in your spreadsheet with your notes 

i. Save your spreadsheet with a file format compatible with multiple 
tabs, if you do this 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Structuring data in spreadsheets 

1. Put all your variables in columns - the thing you’re measuring, like ‘length’ 
or ‘attendance’ 
 

2. Put each observation in its own row 
 

3. Don’t combine multiple pieces of information in one cell 
 

4. Leave the raw data, raw 
 

5. Export the cleaned data to a text-based format like CSV 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If you were to keep track of data like this.. 

The problem? 
 
The number of attendees 
of different types 
(post-grad researcher 
(PGR), post-doc research 
associate (PDRA), & 
other) are in the same 
field.  
 
The solution? 
 
Put attendee categories 
in different columns. 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Columns for variables, rows for observations 

Columns = variables 
 
Rows = observations 
 
Cells = data (values) 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Formatting 
problems 

Common spreadsheet errors 

1. Multiple tables 
2. Multiple tabs 
3. Not filling in zeros 
4. Using bad null values 
5. Using formatting to convey 

information 
6. Using formatting to make the 

data sheet look pretty 
7. Placing comments or units in 

cells 
8. More than one piece of 

information in a cell 
9. Field name problems 

10. Special characters in data 
11. Inclusion of metadata in data 

table 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Multiple tables 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Multiple tabs 

When you create extra tabs, you fail to allow 
the computer to see connections in the data. 
Say you make a separate tab for each year, 
this is bad practice for 2 reasons: 
 

● You are more likely to add 
inconsistencies to your data if each 
time you take a measurement, you 
record it in a new tab 

● You will add an extra step for yourself 
before you analyze the data because 
you will have to combine these data 
into a single data table.  

Ask yourself: “Self, could I avoid adding this 
tab by adding another column to my 
original spreadsheet?” 
 
This can get long, so you can freeze column 
headers: 
 
Documentation on how to freeze column 
headers in Microsoft Excel 
Documentation on how to freeze column 
headers in LibreOffice Calc 
Documentation on how to freeze column 
headers in Google Sheets 

https://support.office.com/en-ca/article/Freeze-column-headings-for-easy-scrolling-57ccce0c-cf85-4725-9579-c5d13106ca6a
https://support.office.com/en-ca/article/Freeze-column-headings-for-easy-scrolling-57ccce0c-cf85-4725-9579-c5d13106ca6a
https://help.libreoffice.org/Calc/Freezing_Rows_or_Columns_as_Headers
https://help.libreoffice.org/Calc/Freezing_Rows_or_Columns_as_Headers
https://support.google.com/docs/answer/9060449?co=GENIE.Platform%3DDesktop&hl=en
https://support.google.com/docs/answer/9060449?co=GENIE.Platform%3DDesktop&hl=en
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Not filling in zeroes 

● There’s a difference between a zero and a blank cell in a spreadsheet.  
○ To the computer, a zero is actually data - you measured or counted 

it.  
○ A blank cell means that it wasn’t measured and the computer will 

interpret it as a null value. 
 
● Spreadsheets or statistical programs will likely misinterpret blank cells 

that are meant to be zero - this is the equivalent to leaving out data. Zero 
observations are real data! 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Using bad null values 

Example: using -999, other numerical values, zero, or text to represent missing 
values. Whatever the reason, it’s a problem if unknown or missing data is 
recorded as -999, 999, or 0. Many statistical programs will not recognize that 
these are intended to represent missing (null) values. How these values are 
interpreted will depend on the software you use to analyze your data. 
 
Solution: A solution will depend on the final application of your data and how you 
intend to analyse it, but it is essential to use a clearly defined and consistent null 
indicator. Blank cells are the best choices for most applications; when working in 
R, NA may be an acceptable null value choice. 

If null values convey different reasons why the data is missing, 
consider creating a new column like data_missing to capture 

the reasons for missing data! 



Null 
Values Problems Compatibility Recommendation

Blank Hard to distinguish values that are missing from 
those overlooked on entry. Hard to distinguish 
blanks from spaces, which behave differently.

R, Python, 
SQL, Excel

Best option

NA, na Can also be an abbreviation (e.g., North 
America), can cause problems with data type 
(turn a numerical column into a text column). NA 
is more commonly recognized than na.

R Good option

N/A An alternate form of NA, but often not compatible 
with software.

Avoid

NULL Can cause problems with data type. SQL Good option

None Uncommon. Can cause problems with data type. Python Avoid
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Example: highlighting cells, rows or columns that should be excluded from an 
analysis, leaving blank rows to indicate separations in data. 
 

Using formatting to convey information 



Solution: create a new field to encode which data should be excluded. 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Example: merging cells. 
 
Solution: If you’re not careful, formatting a worksheet to be more 
aesthetically pleasing can compromise your computer’s ability to see 
associations in the data. Merged cells are an absolute formatting NO-NO 
if you want to make your data readable by statistics software. Consider 
restructuring your data in such a way that you will not need to merge 
cells to organize your data. 

Using formatting to make the data sheet look pretty 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Placing comments or units in cells 
Example: Your data was collected, in part, by a summer student who you later 
found out was mis-recording the duration of training sessions, some of the time. 
You want a way to note these data are suspect. 
 
Solution: Most statistical programs can’t see Excel’s comments, and would be 
confused by comments placed within your data cells. As described above for 
formatting, create another field if you need to add notes to cells.  
● Similarly, don’t include units in cells (such as “hours”,“min”): ideally, all the 

units or measurements you place in one column should be of the same 
standard, but if for some reason they aren’t, insert another column and 
specify the units. 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More than one piece of information in a cell 

Example: One table recorded attendance by the different types of 
attendees. This table recorded the number of attendees of different 
types: post-graduate researcher (PGR), postdoctoral research associate 
(PDRA), and others. 
 
Solution: Never include more than one piece of information in a cell. 
Design your datasheet to include a column for each type of attendee, 
if this information is important to collect, rather than just a total 
number. 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Field name problems 
Choose descriptive field names, but be careful not to include: spaces, numbers, 
or special characters of any kind.  
● Spaces can be misinterpreted by parsers that use whitespace as delimiters 

and some programs don’t like field names that are text strings that start with 
numbers.  

● Underscores (_) are a good alternative to spaces and consider writing names 
in CamelCase to improve readability.  

● Remember that abbreviations that make sense at the moment may not be so 
obvious in 6 months.  

● Including the units in the field names avoids confusion and enables others 
to readily interpret your fields. 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Good Name Good Alternative Avoid

Max_temp_C MaxTemp Maximum Temp (°C)

Precipitation_mm Precipitation precmm

Mean_year_growth MeanYearGrowth Mean growth/year

sex sex M/F

length length l

cell_type CellType Cell Type

Observation_01 first_observation 1st Obs
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Special characters in data 

Example: You treat Excel as a word processor when writing notes, even copying 
data directly from Word or other applications. 
 
Solution: This is a common strategy. For example, when writing longer text in a 
cell, people often include line breaks, em-dashes (--), et al in their spreadsheet. 
When exporting this data into a coding/statistical environment or into a relational 
database, dangerous things may occur, such as lines being cut in half and 
encoding errors being thrown. 

General best practice is to avoid adding characters such as 
newlines, tabs, and vertical tabs. In other words, treat a text 
cell as if it were a simple web form that can only contain text 

and spaces. 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Inclusion of metadata in data table 

Example: You add a legend at the top or bottom of your data table explaining 
column meaning, units, exceptions, etc. 
 
Solution: While recording data about your data (“metadata”) is essential, this 
information should not be contained in the data file itself. Unlike a table in a 
paper or a supplemental file, metadata (in the form of legends) should not be 
included in a data file since this information is not data, and including it can 
disrupt how computer programs interpret your data file.  
● Rather, metadata should be stored as a separate file in the same 

directory as your data file, preferably in plain text format with a name 
that clearly associates it with your data file.  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Dates as data 
● Storing dates in one column is 

not a good practice. 
● Spreadsheet programs may 

display the dates incorrectly 
(for readability) but how it 
actually stores the dates may 
be problematic. 

● Date information may be 
changed when data is 
converted to different 
spreadsheet formats, such as 
between .xlsx and .csv
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Date formats in spreadsheets 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Displaying dates 

Ambiguity may creep into your data 
in numerous ways depending on the 
format you choose when you enter 
your data. You may find that Excel 
will interpret your data in 
unexpected ways later.  
 
The display format of each cell can 
be modified.  
 
To change the display in Excel:  

● Navigate to the Format menu 
and choose “Cells…” 

● In the “Format Cells” dialog 
box, you can select a Date 
format and choose various 
display outputs. 

● In the dialog box, you can also 
choose to format the cell as a 
number or text. It may be useful 
to format as one or the other 
because spreadsheet programs 
understands date information as 
a number.. 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Spreadsheet applications, including Excel, store dates as a number. 
 
Developers chose a single day to designate as day zero, and each subsequent day 
is incremented by a value of one. For example, Excel counts the days from a 
default of December 31, 1899. Thus, July 2, 2014 is stored as the serial number 
41822 because it is 41,822 days after day zero.  
 
Understanding that these programs use serial numbers to process dates can 
be useful – you can easily add days, months, or years to a given date.  

Storing dates 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Say you had a sampling plan where you need to sample 
every 37 days.. 

 
 
 
 
This would display: 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Working with historical dates 

Excel is unable to parse dates from before 1899-12-31, and will thus leave these 
untouched. If you’re mixing historic data from before and after this date, Excel 
will translate only the post-1900 dates into its internal format, thus resulting 
in mixed data. If you’re working with historic data, be extremely careful with 
your dates! 
 
Excel also entertains a second date system, the 1904 date system, as the default 
in Excel for Macintosh. This system will assign a different serial number than the 
1900 date system. Because of this, dates must be checked for accuracy when 
exporting data from Excel (look for dates that are about 4 years off). 

https://support.microsoft.com/en-us/help/214330/differences-between-the-1900-and-the-1904-date-system-in-excel
https://uc3.cdlib.org/2014/04/09/abandon-all-hope-ye-who-enter-dates-in-excel/
https://uc3.cdlib.org/2014/04/09/abandon-all-hope-ye-who-enter-dates-in-excel/
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Useful spreadsheet functions for working with date information 

If a date is entered in one column, we can 
use functions to extract information from 
that column into other columns.  
 
Date-related functions allow us to: 

● convert date values from the stored 
numerical value to a readable display 
value 

● make calculations between date values 
● extract the date values so that they do 

not change as data is transformed or 
exchanged between new users and 
systems. 

Please remember that 
functions that are valid 

for one spreadsheet 
program are usually 

guaranteed to be 
compatible only within 

the same family of 
products. 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Action of function Excel LibreOffice

Return the year number represented in 
the referenced cell value

YEAR() YEAR()

Return the month number represented 
in the referenced date serial number

MONTH() MONTH()

Return the day of the month 
represented in the referenced date 
serial number

DAY() DAY()

Calculate and display a date based on 
supplied year, month, and day values

DATE(Year, Month, 
Day)

DATE(Year; Month; Day)

Return the serial number for date 
information supplied as a string

DATEVALUE() DATEVALUE("Text")

Change display of a number by 
applying specified formatting

TEXT(Value, 
"Formatting code to 
apply")

TEXT(Value; 
"Formatting to apply")

Return the current system date NOW() NOW()



support@ace-net.ca 



support@ace-net.ca 

Adding dates - using DATE() function 

Adding years and months and days is slightly trickier because we need to make 
sure that we are adding the amount to the correct entity. 
 
● First we extract the single entities (day, month, or year) 
● We can then add values to do that 
● Finally, the complete date string is reconstructed using the DATE() function. 

 
Note: Time values raise similar challenges. Seconds can be directly added but to 
add hours and minutes you will need to make sure that quantities are added to 
the correct entities. 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Advantages of alternative date formatting 

The display ambiguities discussed can lead to unintended changes or unknown 
errors in your data. Exchanging data between applications or converting data into 
different formats can also create unexpected changes, and cause challenges for 
data interoperability, sharing & reuse, and long-term preservation.  
 
Alternative date formats can help address these issues:  
1. Storing dates as YEAR, MONTH, DAY 
2. Storing dates as YEAR, DAY-OF-YEAR 
3. Storing dates & times as a single string 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YEAR, MONTH, DAY 

In dealing with dates in spreadsheets, we 
recommend separating date data into 
separate fields (day, month, year), which 
will eliminate any chance of ambiguity. 
 

YEAR, DAY-OF-YEAR (DOY) 

YYYYMMDDhhmmss format  
March 24, 2015 17:25:35         20150324172535 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Pivot tables 
A pivot chart is a graphical 
representation of data 
created from a pivot table. It 
allows users to visualize and 
analyze data in a more 
interactive and dynamic 
manner. Pivot charts are 
valuable for summarizing 
and presenting large 
datasets, making it easier to 
draw insights and trends 
from the data. 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Where to find pivot tables in your program 

Microsoft Excel: Under the “Insert” tab in the Excel ribbon  
 
Google Sheets: Click on “Insert” >> Pivot Table 
 
LibreOffice: Choose the Insert Pivot Table command from the main menu or click 
the from the Standard toolbar. 
 
Apple Numbers: In the Numbers menu bar at the top of your screen, choose 
Organize > Create Pivot Table 

Make sure your data is cleaned and 
errors/inconsistencies are removed 

before inserting a pivot table! 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How to create a pivot table 
1. Select the columns you want to highlight, or use the whole dataset  

a. Let’s highlight C, D, & E  
2. Click on “Insert Pivot Table” or choose where to place it in the existing worksheet.  

a. Let’s choose somewhere near to the rest of the columns, starting at M:1 
3. Set up the pivot table 

a. Drag the “category” field to the “Rows” area 
b. Drag the “quantity” fields to the “Values” area 

4. Create the Pivot Chart: 
a. With the pivot table selected, go to the “Insert” tab in the Excel Ribbon. 
b. Click on the “PivotChart” button and choose the chart type you want to create 

(e.g., a column chart). 
c. A new chart will be generated next to the pivot table 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How to create a pivot table 
● Customize the Pivot Chart: 

a. Add chart titles, axis labels, and data labels to enhance the readability of the 
chart. 

● Interact with the Pivot Chart: 
a. As the pivot table data changes, the pivot chart will automatically update to 

reflect the new data. 
b. You can also use the drop-down arrows on the pivot chart to filter and drill 

down into specific data subsets. 
 

Pivot charts offer dynamic capabilities that make data exploration and analysis 
more interactive and effective. 



Basic quality 
assurance & 

control 

When you have a well-structured 
data table, you can use several 
simple techniques within your 
spreadsheet to ensure the data you 
enter is free of errors. These 
approaches include:  
● techniques that are 

implemented prior to entering 
data (quality assurance) 

● techniques that are used after 
entering data to check for 
errors (quality control). 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Quality assurance 

Quality assurance stops bad data from 
ever being entered by checking to see if 
values are valid during data entry.  
 
To control the kind of data entered into 
a spreadsheet we use Data Validation 
(Excel, Google Sheets) or Validity 
(LibreOffice Calc), to set the values that 
can be entered in each data column. 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Where to find data validation in your program 

Microsoft Excel: Under the “Data” tab in the Excel ribbon  
 
Google Sheets: Click on “Data” >> Data Validation 
 
LibreOffice: Click on “Data” >> Validity  
 
Apple Numbers: Numbers doesn’t have a data validation option. You can, 
however list all your values in column, select them, and set the Data Format 
(under Cell) to Pop-Up Menu. This will create a Pop-up Menu in each cell. You can 
copy-paste one anywhere you like. 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Quality control 

readme (README) files:  
 
As you start manipulating your data files, create a readme document / text  
file to keep track of your files and document your manipulations so that they 
 may be easily understood and replicated.  Your readme file should  
document: 

● all of the files in your data set (including documentation),  
● describe their content and format 
● lay out the organizing principles of folders and subfolders.  
● for each of the separate files listed, document the manipulations or analyses that were 

carried out on those data. 
 
Cornell University’s Research Data Management Service Group provides detailed guidelines for 
how to write a good readMe file, along with an adaptable template. 

https://data.research.cornell.edu/content/readme
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Sorting 
Bad values often sort to bottom or top of 
the column.  
 
For example, if your data should be 
numeric, then alphabetical and null data 
will group at the ends of the sorted data. 
Sort your data by each field, one at a time. 
Scan through each column, but pay the 
most attention to the top and the bottom 
of a column. If your dataset is 
well-structured and does not contain 
formulas, sorting should never affect the 
integrity of your dataset. 

Let’s try this in our Dates tab: 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Conditional formatting 

● Conditional formatting basically 
can do something like colour code 
your values by some criteria or 
from lowest to highest.  

● This makes it easy to scan your 
data for outliers.  

● Use with caution! We can also do 
these checks in a programming 
language like Python or R, or in 
OpenRefine or SQL.  

Let’s try this in the Dates tab: 
 
1. Make sure the num_attended 

column is highlighted. 
2. Go to Format then Conditional 

Formatting, click +. 
3. Apply any 2-Color Scale 

formatting rule. 
4. Now we can scan through and 

different colors will stand out. Do 
you notice any strange values? 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Exporting data 
from 
spreadsheets 

It is not a good idea to store the 
data you’re going to work with for 
your analyses in Excel file formats 
(.xls or .xlsx). Why? 
● Excel is a proprietary format - 

it is possible it may not exist in 
the future (think about zip 
drives/floppy disks!) 

● Other spreadsheet software 
may not be able to open Excel 
format 

● Different versions of Excel may 
handle data differently, leading 
to inconsistencies 

Exporting cleaned data as .csv
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Storing data in a universal, open, static format 

Try tab-delimited or CSV (more common). CSV files are plain text files where the 
columns are separated by commas, hence ‘comma separated variables.’  
 
Advantages: 
● We can open and read a CSV file using almost any software 
● Data in a CSV can also be easily imported into other forms and environments, 

such as SQLite and R 
● Offers maximum portability and endurance  

 
Backwards compatibility: you can open CSVs in Excel! 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A note on cross-platform operability 
By default, most coding and statistical environments expect UNIX-style line 
endings (ASCII LF character) as representing line breaks. However, Windows 
uses an alternate line ending signifier (ASCII CR LF characters) by default for 
legacy compatibility with Teletype-based systems.. 
 
When exporting to CSV using Excel, your data in text format will look like this: 
data1,data2<CR><LF>1,2<CR><LF>4,5<CR><LF>

 
When opening your CSV file in Excel again, it will parse as follows: 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A note on Python & R 

There are Python & R packages that can read xls files (as well as Google Sheets). 
It is even possible to access different worksheets in the xls documents. 
 
But: 
● this equates to replacing a (simple but manual) export to csv with additional 

complexity/dependencies in the data analysis Python code 
● data formatting best practices STILL apply 
● Is there really a good reason why csv (or similar) is not adequate? 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Combining Excel with other tools 
Data cleaning/data wrangling? Consider 
OpenRefine 
 

● Transform data to make it more 
appropriate and valuable for a variety 
of purposes such as data analytics 

● Easy to use – uses ‘clustering 
technology’: easy to find and correct 
spelling variations 

● No need to learn programming 
language syntax or commands 

● Can handle tens of thousands of rows 

Advanced data analytics? Consider R or 
Python 
 

● Both can handle much larger volumes 
of data, and therefore, more analysis 

● R is designed to be reproducible and to 
create more detailed visualizations 

● Python can replace mundane tasks 
with automation 

○ Greater efficiency and scalability 
○ Faster for automation and 

calculating complex equations, 
algorithms  

https://openrefine.org/docs/manual/installing
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Further resources 
Hadley Wickham, Tidy Data, Vol. 59, Issue 10, Sep 2014, Journal of Statistical Software. 
http://www.jstatsoft.org/v59/i10. 
 
White, E., Baldridge, E., Brym, Z., Locey, K., McGlinn, D., & Supp, S. (2013). Nine simple ways to 
make it easier to (re)use your data. Ideas in Ecology and Evolution, 6(2). 
https://doi.org/10.4033/iee.2013.6b.6.f  
 
Date & time sources 

● The Earth Systems Research Lab provides this calendar that displays day of year information 
for any year you select: https://www.esrl.noaa.gov/gmd/grad/neubrew/Calendar.jsp. 

● The U.S. National Snow and Ice Data Center provides a useful chart to calculate the day of 
year: https://nsidc.org/support/faq/day-year-doy-calendar. 

● Microsoft Excel date and time functions reference. 
● LibreOffice Date & Time Functions Reference v. 6.2. 

https://www.jstatsoft.org/v59/i10
https://ojs.library.queensu.ca/index.php/IEE/article/view/4608
https://www.esrl.noaa.gov/gmd/grad/neubrew/Calendar.jsp
https://nsidc.org/support/faq/day-year-doy-calendar
https://support.microsoft.com/en-us/office/date-and-time-functions-reference-fd1b5961-c1ae-4677-be58-074152f97b81
https://help.libreoffice.org/6.2/en-US/text/scalc/01/04060102.html
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